
Статический
 конструкционный анализ: 

последовательность 
решения задачи 

Тема
 

№ 1

Workbench  версии 10 и 11
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Модули
 

ANSYS Workbench
 

версии 10

DesignModeler FE Modeler

CFX-Mesh

Simulation DesignXplorer

 

(VT)

ANSYS Workbench

•
 

Создание
 

геометрической модели

•
 

Генерация сетки

•
 

Расчет 
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Запуск
 

ANSYS Workbench
•

 

Существует
 

три способа запустить ANSYS Workbench
 

и приступить к работе 
в интерфейсе.
1.

 

Непосредственно через меню CAD

 

программы:

2.

 

Через стартовое меню Windows:

3.

 

Через стартовое окно 
ANSYS Launcher:
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Трансляция
 

геометрической модели
•

 

Существует
 

два способа активизировать вычислительный модуль и 
импортировать в него геометрическую модель из внешней CAD программы:
1.

 

Запустить ANSYS Workbench, затем указать название и местоположение 
файлов через интерфейс

 

ANSYS Workbench

2.

 

Транслировать геометрическую модель из интерфейса

 

CAD программы и 
одновременно запустить вычислительный модуль
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Интерфейс
•

 
Компоненты

 
пользовательского интерфейса:

Дерево

 
проекта

Окно

 

настроек

Графическое

 

окно

Инструменты

Мастер

 
расчетов

Меню

Вкладки

 

Workbench

Окно

 

сообщений
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Меню
•

 
Наиболее

 
часто используемые команды меню: 

–
 

в названии рабочего окна присутствует информация об 
активном приложении ANSYS

 
(здесь Workbench);

–
 

“File > Save” –
 

сохранить базу данных в файл
 

.dsdb;
–

 
“File > Clean” –

 
удалить сетку и расчетные результаты из 

базы данных;
–

 
“Edit > Select All” –

 
выбрать все текущие объекты рабочего 

окна;
–

 
“Units” –

 
изменить систему единиц измерения;

–
 

“Tools > Options… ” –
 

изменить настройки;
–

 
“Help > ANSYS Simulation Help” –

 
вызвать справочную 

информацию.
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Инструменты
•

 
Существует

 
4 набора инструментов для быстрого доступа 

к командам, содержащимся в разделах меню.

–
 

Можно изменить расположение инструментов в верхней 
части окна. 

–
 

Набор контекстных инструментов изменяется в зависимости 
от выбранной позиции дерева проектов.

–
 

При помещении курсора в поле инструмента появляется 
всплывающая подсказка. 

–
 

Доступны инструменты изменения системы единиц. 

Стандартные

Графические

Выбор

 

объектов

Контекстные
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… Инструменты

•
 

Стандартные
 

инструменты:

•
 

Графические инструменты:

–

 

Левая клавиша мыши может работать либо с инструментами выбора 
объектов, либо с инструментами управления изображением.

–

 

Объекты CAD геометрии можно выбрать, указав мышью каждый 
объект отдельно или ограничив область выбора контуром. 
Переключение осуществляется пиктограммой «Выбор». 

Сохранить

 

.dsdb Вывести

 

мастер 
расчетов

РешитьСоздать

 

или открыть 
базу данных

 

.dsdb
Сохранить

 

изображение в файл

Управление

 

изображением:

 
поворот, перенос, масштаб

Выбираемые

 

объекты: 
точки, линии, 
поверхности или объемы

Выбор

 
смежных 
объектов

Каркасное

 
изображение

Полно-

 
экранное 
изображение

Выбор: 
одиночный

 
или внутри 
контура

Ракурс
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Дерево
 

проекта
•

 
В дереве проекта организованы все этапы расчета: 
геометрическая модель, материалы, сетка, нагружение, 
расчетные результаты. 
–

 
Через дерево проекта осуществляется 
быстрый доступ к настройкам 
всех этапов расчета.

–
 

В разделе
 

“Model” содержатся 
исходные данные для расчета.

–
 

“Geometry” –
 

геометрическая модель. 
–

 
“Contact” –

 
контактные условия.

–
 

“Mesh” –
 

сетка. 
–

 
“Environment”

 
–

 
нагружение.

–
 

“Solution”
 

–
 

расчетные результаты.
–

 
“Engineering Data” –

 
свойства 

материалов и граничные условия 
(например, конвекция). 
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… Дерево проекта

•
 

Разделы
 

дерева проекта маркируются символами 
текущего статуса. Значение символов статуса: 
–

 
раздел полностью определен и готов к расчету;

–
 

неполные данные, следует ввести недостающие;
–

 
следует провести расчет; 

–
 

проблемные данные, следует изменить;
–

 
объект подавлен, для него вычисления не проводятся;

–
 

объект скрыт, не выводится в графическом окне; 
–

 
позиция в данный момент активирована; 

–
 

генерация сетки по заданной разметке невозможна. 

•
 

Символы статуса позволяют быстро оценить готовность 
проекта к расчету.
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Настройки

•
 

Окно
 

настроек дает доступ к назначению и изменению 
параметров.

 
Содержание окна настроек меняется в 

зависимости от позиции, выбранной в дереве проекта.
–

 
Белое поле: параметры. 

•

 

Данные можно редактировать: следует
 выбрать поле и изменить значение.

•

 

При редактировании данных следует 1) выбрать 
геометрические объекты в рабочем окне, затем 
нажать кнопку “Apply”, 2) либо набрать новое 
значение на клавиатуре, 3) либо выбрать 
необходимую позицию в списке.

–
 

Серое
 

(или красное) поле: информация.
•

 

Данные нельзя редактировать (это максимальное 
напряжение, количество узлов сетки и т.п.).

–
 

Желтое поле: незаданные параметры. 
•

 

Параметры не заданы; следует ввести 
численные значения или сделать выбор, 
чтобы полностью определить задачу. 
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Рабочее
 

окно
•

 
В

 
рабочем окне выводится геометрическая модель, а 

также -
 

расчетные результаты, табличные данные, 
графики, отчеты HTML.

 
Переключение функций рабочего 

окна осуществляется через вкладки.

Вкладка

 

геометрии Вкладка

 

таблиц

Вкладка

 

предварительного 
просмотра перед печатью Вкладка

 

просмотра отчета

Вкладка

 

статуса

Вкладка

 

статуса содержит 
информацию о работах, 
выполненных 
дистанционно. 
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Мастер
 

расчетов
•

 
Мастер

 
расчетов напоминает пользователю, какие 

действия следует выполнить, чтобы провести решение. 
–

 
Последовательно перечислены все шаги решения 
и указан статус выполнения каждого шага. 

–
 

Шаг выполнен.
–

 
Параметры можно изменять.

–
 

Шаг нельзя выполнить. Следует сначала 
выполнить предыдущие шаги. 

–
 

Параметры не определены. При этом в дереве 
проекта соответствующая позиция 
промаркирована аналогичным символом

–
 

Шаг обязательно следует выполнить.  
–

 
Задача готова к решению. В стандартных 
инструментах следует нажать пиктограмму

•

 

В стандартных инструментах мастер расчетов может быть 
включен или выключен нажатием пиктограммы
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Начальная
 

панель
•

 
После

 
запуска программы и трансляции геометрической 

модели высвечивается начальная панель, которая 
позволяет выбрать тип задачи и соответствующий 
шаблон расчетов. 

•

 

Начальную панель 
можно 
отключить в меню: 
“Tools > Options … > 
Simulation: Startup”
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Формирование дерева проекта
•

 
Начальная

 
панель содержит мастер расчетов и предоставляет 

возможность выбрать тип решаемой задачи. 
–

 
При включении программы на начальной панели перечислены 
типы решаемых задач и список разрешенных лицензией. 

–
 

Например, при выборе на начальной панели позиции “Static 
structural” (расчет напряжений) формируются автоматически 
шаги мастера расчетов (справа) и позиции дерева проекта 
(слева), включая список расчетных результатов. 
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Всплывающие
 

подсказки
•

 
При

 
выборе каждого шага в мастере расчетов появляется 

всплывающая подсказка.
–

 
Например, при выборе шага “Verify Materials” (изменение 
материала) подсказка сообщает, как изменить свойства: 1) 
выбрать деталь; 2) выбрать в списке материал; 3) просмотреть 
или изменить 
свойства 
во вкладке 
“Engineering Data”

 над верхней 
строчкой 
меню.
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Список
 

функций мастера расчетов
•

 
Мастер

 
расчетов подсказывает, 

как можно выполнить действие 
через меню. 

•
 

В мастере расчетов доступны 
основные операции и 
расширенные возможности.

•
 

Справа приведены 
расширенные возможности, 
доступные через мастер 
расчетов.  
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Геометрическая
 

и сеточная модель 
•

 
Цель

 
конечно-элементного анализа –

 
найти отклик системы на 

заданное внешнее воздействие.

•
 

Для решения используется математическая модель: 
–

 

геометрическая модель CAD вместе с заданным нагружением
 представляет собой формализованную физическую модель;

–

 

конечно-элементная сетка
 

является математическим 
представлением геометрической модели CAD; это расчетная модель;

–

 

точность расчетов определяется допущениями  физической модели 
и плотностью сетки. 

CAD -

 

геометрическая модель САЕ

 

-

 

конечно-элементная сеточная 
модель
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Последовательность
 

решения 
•

 
Решение

 
задачи проходит через 4 ступени. 

–
 

Основные допущения
•

 

Выбор типа анализа: статический, 
вибрационный?

•

 

Выбор контактной модели: деталь или сборка?
•

 

Выбор типа элементов: оболочечные 
или твердотельные?

–
 

Препроцессинг
•

 

Трансляция геометрической модели. 
•

 

Задание свойств материалов. 
•

 

Генерация сетки.
•

 

Нагружение
 

и закрепление конструкции.
•

 

Выбор расчетных параметров.
–

 
Расчет

–
 

Постпроцессинг
•

 

Просмотр результатов.
•

 

Проверка достоверности решения. 

Препроцессинг

Расчет

Постпроцессинг

Основные
 допущения
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Основные шаги 
•

 
Решение

 
задачи о напряженно-деформированных 

состояниях включает следующие шаги.

•
 

Основные шаги конструкционного анализа. 
1.

 
Транслировать геометрическую модель из CAD

 
системы. 

2.
 

Задать свойства материалов. 
3.

 
Сгенерировать сетку. 

4.
 

Закрепить модель. 
5.

 
Приложить нагрузки.

6.
 

Выбрать параметры решателя. 
7.

 
Задать список расчетных результатов и провести расчет. 

8.
 

Просмотреть расчетные результаты. 
9.

 
Сгенерировать отчет.
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Шаг
 

1.
 

Импортировать CAD
 

модель
•

 
Геометрическую

 
модель можно транслировать в САЕ-

 программу
 

двумя способами. 
1.

 
Прямая трансляция из интерфейса CAD и одновременный 
запуск расчетного модуля (действует для поддерживаемых 
CAD

 
программ).

2.
 

Трансляция
 

CAD модели через интерфейс САЕ программы 
(действует для поддерживаемых форматов файлов).

Трансляция

 

CAD модели через 
интерфейс САЕ программы

 
(plug-in mode)

Поиск

 

и чтение CAD файла

 
(reader mode)

Прямая

 

трансляция из 
интерфейса CAD и 
одновременный запуск 
расчетного модуля (plug-in mode)

Способ

 

1 Способ

 

2
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Шаг
 

2.
 

Задать свойства материалов
•

 
После

 
трансляции геометрической модели в САЕ программу следует 

выбрать тип анализа  -
 

Stress Branch
 

(расчет напряжений), 
появляется мастер расчетов -

 
Stress Wizard.

–
 

В мастере расчетов следует выбрать позицию “Verify Materials” 
(изменить материалы), всплывающая подсказка информирует, 
как провести изменение.  

При

 

выборе в мастере 
расчетов

 

позиции “Verify 
Materials”

 

высвечиваются все 
позиции раздела

 

“Geometry” 
в дереве проекта; в окне 
настроек доступны позиции 
для изменения свойств 
материалов любых деталей 
сборки.
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… База данных материалов
•

 
В окне настроек возможен выбор материала из списка. 
–

 
По умолчанию всем деталям присваиваются свойства 
конструкционной стали “Structural Steel”, которые можно 
изменить.

–
 

Выбрав в списке позицию
 

“browse …” (поиск), пользователь 
получает возможность указать местоположение файла со 
свойствами материала в формате *.XML.

–
 

В стандартном списке присутствует несколько распространенных 
материалов, но пользователь может создать и использовать 
свою базу данных

 
материалов.
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… Материалы деталей в сборке
•

 
Для

 
каждой детали можно назначить свой материал. 

–
 

Название детали транслируется из CAD модели. 
•

 

Одинаковые детали (например, болты) различаются присвоенными 
при трансляции порядковыми номерами. 

–
 

Одинаковые детали можно выбрать и изменить одновременно. 
•

 

Используйте клавиши Shift-левая мыши для выбора нескольких 
деталей и Ctrl-

 

левая мыши  -
 

для выбора (или отказа) отдельных 
деталей. 

Клавишами

 

Shift-левая мыши и 
затем Ctrl-левая мыши в 
дереве проекта выбраны 12 
деталей. 

Пользователь может 
назначить для выбранных 
деталей один материал, 
выбрав его из списка в окне 
настроек.
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… Доступ к свойствам
•

 
Чтобы

 
получить доступ к свойствам материалов, следует 

нажать пиктограмму Data
 

в меню
–

 
появится вкладка “Engineering Data” (свойства материалов) 
выше верхней строки меню; следует перейти в эту вкладку
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… Редактирование свойств

•
 

Свойства
 

материалов приведены во вкладке “Engineering 
Data” (свойства материалов).
–

 
Свойства можно изменить и затем экспортировать в файл базы 
данных, либо импортировать из внешнего файла.

–
 

Можно выбрать материал, присваиваемый по умолчанию и 
список предпочтительных материалов.
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Шаг
 

3.
 

Сгенерировать сетку
•

 
Выбрав

 
раздел “Mesh” (сетка) в дереве проекта, можно 

изменить или задать плотность сетки.

•
 

Существует несколько развитых инструментов контроля 
за плотностью сетки. При построении сеточной модели 
необходимо искать оптимальную дискретность сетки и 
балансировать при этом между задействованными 
ресурсами вычислительной системы (память, время и т.п.) 
и точностью вычислений. 
–

 
Сетка с большим количеством расчетных узлов позволяет 
находить более точное решение, но увеличивает расчетное 
время и объем памяти. 

–
 

В идеале решение не должно зависеть 
от плотности сетки.

•

 

Эта проблема решается через контроль 
за сходимостью  (Convergence controls).

–
 

Измельчение сетки не компенсирует ложные 
допущения физической модели и ошибки 
входных данных.



2009
http://cae.ustu.ru

© О. М. Огородникова

КО
М
П
Ь
Ю
ТЕРН

Ы
Й
И
Н
Ж
ЕН

ЕРН
Ы
Й

 А
Н
А
ЛИ

З
КО

М
П
Ь
Ю
ТЕРН

Ы
Й

КО
М
П
Ь
Ю
ТЕРН

Ы
Й

КО
М
П
Ь
Ю
ТЕРН

Ы
Й
И
Н
Ж
ЕН

ЕРН
Ы
Й

 А
Н
А
ЛИ

З
И
Н
Ж
ЕН

ЕРН
Ы
Й

 А
Н
А
ЛИ

З
И
Н
Ж
ЕН

ЕРН
Ы
Й

 А
Н
А
ЛИ

З
CAEngineering

28

Шаг
 

4.
 

Закрепить модель
•

 
После

 
назначения материалов в мастере расчетов следует 

выбрать позицию “Insert Supports” (задать закрепление)
–

 
В контекстных инструментах появляются пиктограммы 
конструкционных и тепловых нагрузок.

После

 

выбора позиции в 
мастере расчетов “Insert 
Loads”

 

или “Insert 
Support”

 

высвечивается 
раздел “Environment” в 
дереве проекта.

При этом изменяются 
контекстные 
инструменты и окно 
настроек.
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Шаг 5.
 

Нагрузить модель
•

 
Нагрузки

 
и закрепление применяются к геометрическим 

объектам. 

•
 

Существует два способа приложить нагрузки. 
1.

 
Сначала выбрать геометрический объект в графическом окне, 
затем выбрать нагрузку или закрепление в контекстных 
инструментах. 

2.
 

Сначала выбрать нагрузку или закрепление в контекстном 
меню, затем выбрать геометрический объект в графическом 
окне и нажать “Apply” (применить) в окне настроек. 
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… Величина нагрузки

•
 

После
 

приложения нагрузок к геометрическим объектам 
можно ввести дополнительные данные в окне настроек.
–

 
После приложения нагрузок изменяется символ статуса для 
соответствующего раздела в дереве проекта.
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… Направление вектора нагрузки
•

 
Для

 
некоторых нагрузок необходимо указывать направление. 

–

 

Направление нагрузки задается в окне настроек для нагружения. 
•

 

Если выбрана позиция “Components” (компоненты) 
в списке, следует ввести значение нагрузки 
в направлениях X, Y, Z.

•

 

Если выбрана позиция

 

“Vector” (вектор), 
следует указать направление на геометрической 
модели и ввести значение нагрузки. 

•

 

Установки по умолчанию задаются в меню:

 
“Tools > Options … > Simulation: Miscellaneous 
> Load Orientation Type”

–

 

При задании направления можно ссылаться 
на глобальную систему координат.

•

 

Направление осей координат показано в графическом окне. 
•

 

Направление и начальная точка глобальной системы 
координат передается из CAD системы.

•

 

В окне настроек для нагрузки следует выбрать 
позицию “Define By:Components”

 

и ввести 
компоненты нагрузки в направлениях x, y, z.

•

 

Можно задать и определить произвольную декартову 
систему координат, не связанную с исходными  
CAD

 

данными.
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… Привязка вектора к геометрии
–

 
При

 
задании направления можно также ссылаться на 

геометрическую модель. 
•

 

Для этого следует в окне настроек для нагрузки 
выбрать позицию “Define By: Vector” (задать вектор).

•

 

Можно использовать 3 типа геометрических объектов. 
1.

 

Нормаль к плоскость или ось цилиндрической 
поверхности. 

2.
 

Прямолинейное ребро или нормаль к ребру 
цилиндрической поверхности. 

3.
 

Две точке, определяющие направление вектора. 
•

 

Выберите позицию “Direction” (направление) 
и покажите направление вектора на геометрической 
модели. 
Направление вектора можно сменить 
на противоположное, используя стрелки 
в графическом окне. Задав направление, 
нажмите кнопку “Apply” (применить).

•

 

Введите величину нагрузки в позиции 
“Magnitude”

 

(величина).
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… Функции мыши

•
 

Мышь
 

может выполнять различные функции в 
графическом окне. 
–

 
Левая клавиша мыши

 
используется для выбора 

геометрических объектов или для управления изображением. 

•

 

Функция левой клавиши выбирается в графических инструментах. 
•

 

Можно выбрать тип объектов (vertex

 

-

 

точка, edge

 

-

 

ребро, surface

 

-

 
поверхность, body

 

-

 

объем) или изменение изображения (rotate

 

-

 

поворот, 
pan

 

-

 

смещение, zoom in/out

 

–

 

масштаб увеличить/ уменьшить, box zoom

 

–

 
изображение в контуре увеличить).

•

 

Можно задать опцию выбора –

 

выбор отдельных 
объектов или выбор всех объектов в контуре. 

–

 

При выборе отдельные объекты выделяются цветом. 
–

 

Используйте клавиши Ctrl-левая мыши для выбора нескольких 
отдельных объектов (или отказа). 

–

 

Для выбора объектов в контуре формируйте контур слева направо, 
полностью охватывая контуром выбираемые объекты. 

–

 

Формируя контур справа налево, можно выбрать все объекты, частично 
охваченные контуром. 
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… Функции мыши
–

 
В режиме выбора средняя клавиша мыши управляет 
изображением в графическом окне. 

•

 

Нажатием средней клавиши и перемещением мыши можно динамически 
поворачивать геометрическую модель. 

•

 

Клавишами Shift-средняя мыши можно перемещать геометрию. 
•

 

Колесиком можно изменять масштаб изображения. 
•

 

При работе с колесиком нет необходимости переключать режим работы мыши 
между выбором объектов и управлением изображением.

–
 

Правой клавишей мыши вызывается контекстное меню. 
•

 

Нажатием правой клавиши и перемещением мыши можно выделить область 
изображения для увеличения масштаба. 

•

 

Нажатием правой клавиши и выбором позиции “Fit” в контекстном меню можно 
вывести полное изображение геометрической модели. 

Нажатием

 

правой 
мыши можно вызвать 
контекстное меню. 

Нажатием

 

правой 
клавиши и 
перемещением мыши 
можно выделить 
область для 
увеличения масштаба. 
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… Функции мыши

•
 

Используя
 

функции мыши, можно быстро приложить 
нагрузку к нескольким поверхностям. 
–

 
Клавишами Ctrl-левая мыши можно выбрать несколько 
поверхностей (выбранные объекты окрашены в зеленый цвет).

–
 

Средней клавишей мыши при этом можно поворачивать 
геометрическую модель, чтобы получить возможность 
графически выбрать поверхности в различных ракурсах. 
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Шаг
 

6.
 

Выбрать параметры решателя
•

 
После

 
начального выбора в мастере расчетов шаблона Stress 

Branch (расчет напряжений) в дерево проекта помещаются 
некоторые расчетные параметры по умолчанию. Пользователь 
может изменить и добавить расчетные параметры.

–

 

В мастере расчетов следует выбрать позицию “Insert Results” (добавить 
расчетные параметры), всплывающая подсказка информирует о том, как 
добавить расчетные параметры. 

Раздел

 

“Solution” (решение) в 
дереве проекта выделен.

Окно настроек и контекстные 
инструменты соответствуют 
выделенному разделу “Solution” 
(решение).

Расчетные параметры (stress

 

-

 
напряжения, strain

 

-

 

перемещения, 
deformation

 

–

 

деформация)

 
доступны в списках контекстных 
инструментов. Выбранные 
расчетные параметры появятся в 
разделе “Solution” дерева проекта.
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Шаг 7.
 

Провести расчет
•

 
После

 
назначения материалов, закрепления модели, ее нагружения

 и выбора расчетных параметров задача готова к вычислению.
–

 
Следует выбрать позицию “Solve” (решить) в мастере расчетов. 
После этого появляется всплывающая подсказка, которая 
указывает на пиктограмму, инициирующую расчет.  

Расчету

 

предшествует 
автоматическая генерация сетки, 
если эта операция не была 
выполнена раньше.

Решение может занять несколько 
минут или несколько часов в 
зависимости от сложности модели 
и используемого компьютера. 
Индикатор выполнения показывает 
текущее состояние и необходимое 
расчетное время. 

Расчет можно остановить в окне  
индикатора. 
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… Входные и выходные файлы 
•

 
Расчет

 
выполняется в режиме пакетной обработки (batch).

–
 

При запуске решения формируется входной файл (input file) 
ANSYS,

 
информацию о файле расчетных результатов можно 

запросить в позиции “Solution Information” раздела “Solution” 
(решение) дерева проекта. 

–
 

Расчет можно транслировать в ANSYS
Во

 

вкладке таблиц (Worksheet view) 
графического окна при выделенной 
позиции

 

“Solution Information”

 
выводится содержание файла 
расчетных результатов. Это 
текстовый файл, который можно 
дополнить, например, информацией о 
частотах.

По умолчанию входной файл (input 
file ds.dat), файл расчетных 
результатов

 

(output file solve.out)

 

и 
вспомогательные файлы 
располагаются в системном 
временном каталоге TEMP.

Папку для записи рабочих файлов 
можно изменить в меню:

 

“Tools > 
Options… > Simulation: Solution > 
Solver Working Directory” 
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Шаг
 

8.
 

Просмотреть результаты
•

 
По

 
окончании расчетов можно просмотреть расчетные 

результаты. 
–

 

Расчетные результаты зависят от типа решенной задачи. 
–

 

Расчетные параметры можно вывести контурами или векторами, а 
также анимировать. 

Всплывающая

 

подсказка 
информирует о том, что 
для просмотра расчетного 
параметра следует 
выбрать в дереве проекта 
соответствующую 
позицию.



Последовательность
 решения статической задачи

Лабораторная
 

работа № 1
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Цель
 

работы

•
 

Используя
 

мастер расчетов, 
провести конструкционный 
анализ, найти напряжения, 
деформацию и запас прочности.

•
 

Условия:
–

 

Деталь –
 

крышка. Геометрическая 
модель детали построена в CAD-

 программе и сохранена в файле 
Parasolid

 

формата *x_t.  
–

 

Предполагается эксплуатировать 
крышку в условиях внешнего 
давления 1 МПа.

–

 

Крышка выполнена из 
алюминиевого сплава.

•
 

Задание:
–

 

Убедиться, что крышку можно 
эксплуатировать при заданных 
условиях.
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Допущения
 

физической модели
•

 
Представим

 
взаимодействие детали с 

внешними объектами, используя тип 
закрепления без трения (frictionless support). 
Закрепим деталь по отверстиям, по опорной 
поверхности, по внутренним поверхностям 
паза.

–

 

При закреплении без трения запрещается 
перемещение по нормали к поверхности 
контакта. 

–

 

Разрешено перемещение во всех 
направлениях за исключением нормали 
к плоскости закрепления. В области 
контакта предполагается действие 
сил без трения, т.е. консервативное 
поведение системы (без рассеяния 
энергии).
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Запуск
 

программы
•

 
Запустите

 
расчетный модуль 

из интерфейса Workbench.

•
 

Импортируйте геометрию из файла 
Parasolid: “Geometry > From File . . . “, 
выберите файл “labrab1.x_t”

 
в папке.

•
 

После запуска программы выберите 
шаблон мастера настроек “Static Structural ” 
(конструкционный анализ) и сделайте 
выбор “Ductile materials ”(пластичные

 материалы).
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Условия
 

нагружения
•

 
Нагрузка: давление 1 МПа приложено к 17 внешним 
поверхностям крышки.
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Условия
 

закрепления
•

 
Закрепление: 3 области закреплены без трения.

–

 

Примечание.
 

Если все закрепления определены как закрепления без 
трения, появится предупреждение: «Для одного или нескольких тел 
ограничение степеней свободы задано некорректно, что может 
вызвать жесткое движение тел. Чтобы получить решение, 
необходимо добавить слабые пружины».

–

 

Программа автоматически добавляет слабые пружины в расчетную 
модель, если возможно жесткое движение под действием приложенных

 нагрузок. Проверка граничных условий должна подтвердить, что такое 
движение исключено. В этом случае слабые пружины не влияют на 
расчетные результаты.

•

 

Появится предупреждение о том, что модель будет проверена. Такое

 
предупреждение не означает, что решение будет неверным.

–

 

Слабые пружины могут быть включены/выключены пользователем.
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Выбор
 

единиц измерения
1.

 
Задайте

 
систему единиц измерения в меню: 

“Units > Metric (mm, Kg, MPa, °C, s)”.
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Выбор
 

материала
2.

 
В

 
мастере расчетов выберите позицию “Verify Material”

 (изменить материалы).  Выберите позицию “Material”
 

в окне 
настроек, затем -

 
позицию “Import” в списке, следует выбрать 

файл “Aluminum Alloy”
 

в папке базы данных.

•
 

При
 

изменении 
материала автоматически 
высвечивается позиция

 соответствующей детали 
в дереве проекта.
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Выбор
 

нагружаемых поверхностей

Для
 

приложения нагрузки необходимо выбрать 17 внешних 
поверхностей. Используйте графические инструменты. 

3.
 

Выберите произвольно одну внешнюю поверхность. 

4.
 

В графических инструментах
 

выберите 
“Extend to Limits”

 
(выбрать все границы).
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Задание
 

нагрузки
Приложите

 
к выбранным поверхностям давление :

5.
 

Выберите позицию “Insert Loads” (нагрузить) 
в мастере расчетов.

6.
 

Выберите в контекстных инструментах 
позицию Structural > Pressure.

7.
 

Введите в позиции Magnitude
 

(величина) 
окна настроек

 
значение 1 Mpa.

5 6 7



2009
http://cae.ustu.ru

© О. М. Огородникова

КО
М
П
Ь
Ю
ТЕРН

Ы
Й
И
Н
Ж
ЕН

ЕРН
Ы
Й

 А
Н
А
ЛИ

З
КО

М
П
Ь
Ю
ТЕРН

Ы
Й

КО
М
П
Ь
Ю
ТЕРН

Ы
Й

КО
М
П
Ь
Ю
ТЕРН

Ы
Й
И
Н
Ж
ЕН

ЕРН
Ы
Й

 А
Н
А
ЛИ

З
И
Н
Ж
ЕН

ЕРН
Ы
Й

 А
Н
А
ЛИ

З
И
Н
Ж
ЕН

ЕРН
Ы
Й

 А
Н
А
ЛИ

З
CAEngineering

50

Закрепление
Закрепите

 
деталь

 
(поверхности отверстий).

8.
 

Выберите опорные поверхности 4 отверстий. 

9.
 

Выберите позицию “Insert Supports” (закрепление) в мастере 
расчетов.

10.
 

Выберите в контекстных инструментах позицию Structural > 
Frictionless Support

 
(закрепление без трения).

8

9

10
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. . . Закрепление

Закрепите
 

деталь
 

(поверхности паза):

11.
 

Выберите одну поверхность внутреннего паза. 
Нажмите пиктограмму “Extend to Limits” 
(выбрать все границы), чтобы выбрать еще 
7 поверхностей.

12.
 

Выберите позицию
 

“Insert Supports” 
(закрепление) в мастере расчетов. 

13.
 

Выберите позицию Structural > Frictionless 
Support

 
(закрепление без трения) 

в контекстных инструментах.

12

13 11
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. . . Закрепление

Закрепите
 

деталь
 

(опорная поверхность):

14.
 

Выберите опорную поверхность. 

15.
 

Выберите позицию
 

“Insert Supports” (закрепление) в мастере 
расчетов.

16.
 

Выберите позицию Structural > Frictionless Support
 

(закрепление 
без трения) в контекстных инструментах.

14

15

16
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Расчет
17.В мастере расчетов выберите позицию 

“Solve”
 

(решить).

Всплывающая подсказка указывает на 
пиктограмму в стандартных инструментах, 
которая запускает решение. 
Альтернативный способ –

 
правой 

клавишей мыши вызвать контекстное 
меню в дереве проекта и выбрать 
позицию “solve”

 
(решить).

17
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Расчетные
 

результаты
18.В мастере расчетов выберите позицию “View Results”

 (просмотреть результаты).  Всплывающая подсказка 
указывает на расчетные результаты в дереве проекта. 
Можно выбрать расчетный параметр и просмотреть его 
распределение в графическом окне.

18
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Смещения
•

 
Контроль

 
за величиной смещений позволяет в целом 

оценить правдоподобность проведенных расчетов. 
Эффекты деформации визуально преувеличены в 
графическом окне. Можно анимировать процесс 
деформирования.
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Коэффициент
 

запаса прочности
•

 
Просмотрев

 
напряжения, перейдите к анализу запаса 

прочности. Коэффициент запаса оценивается по двум 
теориям прочности и должен превышать в надежных 
областях значение 1.



Прочность  конструкции

Творческое
 

задание №1
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Техническое
 

задание

•
 

Построить
 

объемную модель 
пластикового стаканчика.

•
 

Раздавить стаканчик,
 приложив нагрузку к донышку.

•
 

Рассчитать усилие, 
при котором

 стаканчик сминается.



Жесткость  конструкции

Творческое
 

задание №2
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Техническое
 

задание

•
 

Построить
 

объемную модель 
токарного резца.

•
 

Зажать резец в суппорте.

•
 

Рассчитать упругий прогиб 
инструмента при точении.
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